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Introduction

Flowchart Maker is a Macintosh program to realize flowcharts.
Flowcharts are diagrams to describe flows but also elements in
relationships, which can represent many situations.
One is for example the flow a procedure has inside a company, from an
order received via fax to the shipment and printing  of an invoice, usually
the flow grows in a manner directly proportioned to the size of a
company…

Another is the hierarchy of people in a company.
It is usually a pyramid, but not always.
Another one is used to describe relationships between elements as
describing functions of objects inside an object oriented program.
There is no limit to the things you can describe using flowcharts.
But I think you already know that.

How to install and launch Flowchart Maker

Flowchart Maker usually comes in a compressed archive.
Decompress it and place the program where you like.
To launch it just double-click as with every Mac program.
You can keep Flowchart Maker documents where you prefer, depends of
the HD organization you use, many prefer to keep the app and related
documents inside a folder, others prefer to keep all the applications in one
Applications folder (everyone inside its own sub folder) and keep all your
documents inside the Documents folder (inside a sub folder).
The second approach is usually preferred because when you upgrade an
application you can simply substitute the application sub folder without
losing your documents.
This method is a bit 'schematic' and a bit similar to the rigid approach
used in UNIX where every kind of file has a proper directory.
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Anyway 'Hard Disk' organization is not the subject of this manual…

The document window
After launching Flowchart Maker a new empty document window will be
opened automatically .

You can have more than one window opened, to open existing documents
select as in any Mac application 'Open' from the 'File' menu and select the
file you like to open.
You can change the scale of representation of the flow chart using the
popup menu at the left bottom of the window, selecting the percentage of
magnification you prefer. You can also use the two icons to step up and
down in the scale of magnification.

All these commands are almost standard in many graphical programs.
If you have opened more of one document windows you can select them
using the 'Win' menu.

Preferences
The preferences dialog let you setup characteristics common to all
documents, a change in the preferences will be transmitted to all opened
documents and quitting the applications the setting will be saved inside
the application preferences, allowing to have them properly setted also
after the successive startup.
To set the preference select 'Preferences…' from the 'Edit' menu.
The preferences dialog will be opened.
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From this dialog you can setup:
The measure unit used in the rulers inside the document window.
You can choose the one you prefer from the popup:

The number formatting.
The action to be taken opening the application.
To confirm your selections click OK.

Options
You have some options regarding the current document.
Selecting 'Visual Grid…' from the 'Option' menu open the dialog:
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This dialog allows you to insert the dimension of the visual grid to use for
your current chart.
To visualize it you have to insert the true dimension and to check 'Show
Grid'.
Note that the visual grid doesn't change the scale magnification of your
chart.
If you select a grid of 2 cm in your draw, when you change the scale the
grid will still be of 2 cm.

The purpose of the visual grid is to offer you a visual help drawing.
You can switch the 'visualize grid' flag 'on the fly' selecting 'Show visual
grid' from the 'Option' menu.

Selecting 'Mouse Grid…' from the 'Option' menu you can specify a grid
the mouse can follow drawing and moving objects.
This 'mouse grid' is adapted changing the scale of magnification.
In this way the mouse will always use the same 'true' dimension.
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You can switch the 'Use grid' flag via menu also using the 'Fit to Mouse
Grid' item of the 'Option' menu.

To define of how many pages your document is formed select 'Drawing
Dimension' from the option menu.
The document will be saved remembering of how many pages is formed.

Note that if you draw or move something outside the document
boundaries it is still valid but it will not be printed.
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To print it increase the drawing dimension, as in the picture assigning 2
pages x 1

The visual grid will expand showing you the area covered by the drawing
area.
The drawing area dimension depends of the number of pages you selected
and from the page size you selected in your page setup dialog.

The show rulers command let you show/hide rulers on the drawing
board.

Tools & Commands

Flowchart Maker operates using tools you can select from a palettes
positioned inside a floating window.
To open the floating window tools select 'Show Tool Palette' from the
'Option' menu.
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The floating window has 3 palettes inside.
The first on top has 3 tools:

The selection arrow (to select and move objects).
The hand (to move the drawing as if it were a piece of paper)
The magnification glass (to increase or decrease the scale of vision).

The middle palette is for connecting line:

- Without arrow
- Monodirection arrow
- Bidirection arrow

The bottom palette is for different kinds of box:

One and only one can be the current selection.
When you select a tool the previous one selected become unselected.

Inserting Box
To insert a box, select the box you prefer from the tool palette  and click
and drag on the document window.
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The drag starts with a click which will be the center of the box, than
maintaining the mouse clicked go to one of the corner of the rectangle
enclosing the box, then release the mouse button.
While dragging an outline of the box will be displayed.

It is easier to do than to say.
Just try.

If you want to move the box select the 'Selection arrow' from the palette
and click and drag to move the box in a new position.
If you want to insert a text in a box just click twice inside the box, then you
can start editing text in editing mode.

In editing mode you type directly inside the box.
To disable the 'Editing' mode just click outside the box.
In any moment to edit a box text you need just a double click.

Connecting Boxes

To connect a box select the connection tool from the palette and click and
release in the first box, then click in the second box and release.

You can also click in any point outside the box if you want external node
of the line.
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In any moment selecting the selection tool you can select a node of the
line and move it.

Appearance

To apply appearance characteristics to a box select it then using the
'Appearance' menu you can select and apply it.

For every different box you can change:
The pen size used to draw the frame
The pen color used for the border

The color for the inner of the box.
The pattern used for the inner of the box.
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The font
The font size
The font style
The font color

Same for the line, selecting it you can apply characteristics using the
'Appearance' menu:

Line size
Line color
Arrow direction

To change appearance faster open the 'Command Palette' from the option
menu and after selecting the object, press the button on the 'Command
Palette'

Buttons on the palette are automatically enabled if the button command
applies to the selection.
From the command palette you can also duplicate a selected object or
show the visual grid and apply the 'Fit to grid' command.
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Saving on disk
Saving file on disk is just as in any standard Mac programs.
The 'Save' command under the file menu saves your document on disk.
To assign a new name use the 'Save as' command.

Printing
Flowchart Maker allows to print on any Mac compatible printer.
The number of pages printed will be according to the pages you specified
in the 'drawing Dimension' dialog.
For example if you inserted 'Width' = 2  and 'Height' = 3 a total of (2 x 3) =
6 pages will be printed.
Pages are printed per row.

Tips

If a common kind of boxes is necessary it is better to define one of them
and duplicate it as many times as requested.

To duplicate an existing box after selecting it you have 3 choices:
- Select 'Duplicate' from the 'Edit' menu
- Command - D
- Click in the command window the 'Duplicate' button.

To add node to a line select the node and ask duplicate in one of the 3
methods explained.

The node will be added after the selected one.
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You have to move it in the desired position.

To change the type of a line arrow, use  the 'line Type' sub menu:

You can switch the Line Type using 'Command-L'

To realize text labels draw a box and edit the desired text

then select ' none' from the 'Pen Size' sub menu of the 'Appearance'
menu
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the box will appear as a normal text label.

To move a box over another one select the box

and select 'Bring to front' from the 'Option' menu

You can also use the 'Bring to Bottom' to obtain the opposite effect.

When you double-click a box to edit its text is ported to the front
automatically.

Manual

The Flowchart Maker Manual you are reading is realized using an auto-
readable program.
You can view it and print it on your printer.

I did my  best to write this manual in correct English.
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By the way English is not my tongue language and I apologize for some
mistakes it contains.

Shareware

In case you don’t know what is shareware…
Think at shareware as the most direct distribution method, directly from
the producer to the user, avoiding distribution costs.
Shareware means freedom of action for developers and very good
software with very good service at low prices for users.
The shareware community on the Macintosh side is very strong, both
from the developers side and from the users side.
Developers work hard to provide state of the art shareware program and
users respect their work.
This doesn't happen on every platform.
Also this make great the Mac, its users.

Registering

If you like Flowchart Maker and use it, please register.

Shareware registration for Flowchart Maker is:

Single User License...............US$ 39 (Personal use)
Site License.............................US$ 490 (Unlimited inside a company)
World Wide License............US$ 1900 (Large Worldwide Company)

To register you can use 'Kagi' company  located in the U.S.A.

Kagi

Kagi is the major shareware registration service at the moment and I
think you already know it because Kagi Service is used from a lot of
shareware authors.
By the way if you don't know it yet this is a brief explanation of how Kagi
service works:

Kagi is a company located in the U.S.A. specialized in collecting shareware
and commercial software fee and sending them to authors.

To Pay via ‘Kagi’ you can send your payment using:
normal mail, email, world wide web, fax.
Additional service : phone order.
All handling service are free for the user except the telephone orders.
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This because the telephone order service is handled by an external
company who sends the orders to Kagi.

To Pay via ‘Kagi’ you can use 3 methods:

1)
Generating a registration form using the 'Register' program included
with the package you want register and sending it to Kagi via:
email
ordinary mail
fax
(Card number is automatically encrypted by the Register program or
secure transmission ).

2)
Using the on-line registration web site (both normal and secure form
available) accessible from http://www.kagi.com/panetta

3)
Telephone Orders:

Using Kagi service you can select the payment method you prefer from :
Cash
Check
Invoice
VISA
Mastercard
American Express
Discover
Diners Club
FirstVirtual.
(On-line registration is for credit card only)

Note: Using Kagi Service do not request additional payment from the
users.
Shareware fee is the same. (The author pays Kagi the service)

The only exception is telephone order.
For telephone order there is a  $4 handling fee and a manditory postcard
receipt $1 you must pay if you like place your registration via phone.

After Kagi receives your payment the author is informed by Kagi within
few hours and you will receive your personal registration directly from
the author.

http://www.kagi.com/panetta
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Telephone Order

Please note: Telephone order is the only service not free
If you use telephone order there is a $4 handling fee and a mandatory
postcard receipt $1

Service available 24 hours a day, 7 days a week
Telephone number:

 +1 (510) 658-5244    (Flowchart Maker by Roberto Panetta)

You will talk to a live person who takes all your payment information and
sends your order to Kagi.
The person who answers the phone is just a telephone operator, not a
Kagi employee.

Internet

Tension Software Web Page

Roberto Panetta maintains the 'Tension Software  Shareware Page' at this
address:
http://www.kagi.com/panetta

From Tension Software  Shareware Page you can read information about
the last version of our software and download it.

Contacting the author

To contact Roberto Panetta send to:
panetta@kagi.com

Legal Note

Copyright
Flowchart Maker is copyright Roberto Panetta. All rights reserved.
No modification of the program and of the documentation included is permitted.

Warranty

http://www.kagi.com/panetta
mailto:panetta@kagi.com
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Flowchart Maker is supplied 'as is'. The author hereby disclaims all warranties related to
this software, whether expressed or implied, including without limitation any implied
warranties of merchantability or fitness for a particular purpose.
The author will not be liable for any special, incidental, consequential, indirect or similar
damages due to loss of data or any other reason, or for any claim by any other part, even if
the author, or an agent of then author as been advised of the possibility of such damages. In
no event shall author' liability for any damages ever exceed the price paid for the license
to use the software, regardless of the form of the claim. The person using the software bears
all risks as to the quality and performance of the software.

Distribution
This software can be distributed in any 'shareware' form the distributor likes, such as CDs,
floppies or via network, as long as the package has all the file of the original package
included and unmodified.
If you are a shareware distributor and you distribute my software I like to know that.
Inclusion in commercial packages are prohibited without previous authorization.


